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Unit-4 

 

Windows Operating System & Internet 

 

1.   Introduction To Windows 

Microsoft Windows is a family of operating systems by Microsoft. They can run on 

several types of platforms such as servers, embedded devices and, most typically, on 

personal computers. Microsoft first introduced an operating environment named Windows 

in November 1985. This operating system has graphical user interface. Windows 32-bit 

operating systems is the family of Windows systems which was designed and marketed 

for higher-reliability business use.  

 

Windows 95 is a 32 bit, multitaking, multithreaded operating system which is capable of 

running DOS, Windows 3.1, and Windows 95 application. It supports plug and play, and 

adds an enhanced FAT(File Allocation Table) file system in the Virtual FAT which 

allows long file name of upto 255 characters 

 

Features Of Windows Operating system 
 

 The start button and task bar are your primary jumps between the programs and 

documents. 

 

 Plug and play is one of the most important features of windows.It is an automatic 

technique designed to make PC configuration simple and straight forward. It frees 

you from normally manual setting of hardware devices. 

 

 It will customize and use resources effectively and efficiently. 

 

 A 32 bit version of Windows deliever better performance and reliability in certain 

areas such as networking, Printing and in multimedia. 

 

 It is preemptive multiprogramming operating system. 

 

ADVANTAGES 
 

(i) Easiest operating system yet 

 Navigate your system quickly with powerful new tools: 

 Plug and play frees you from manually setting up hardware devices. 

Windows 95 detects and configures plug and play-compatible devices 

automatically. 

http://en.wikipedia.org/wiki/Operating_system
http://en.wikipedia.org/wiki/Microsoft
http://en.wikipedia.org/wiki/Server_(computing)
http://en.wikipedia.org/wiki/Personal_computer
http://en.wikipedia.org/wiki/1985
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 Customize and use resources efficiently- just click the right mouse button 

wherever you are working and a context menu appears in order to help 

you manipulate objects directly. 

 Microsoft Exchange is your one-step in box for viewing and working with 

such things as: electronic mail from multiple sources, faxes, documents 

and bullet in boards. 

(ii) A faster, more powerful windows 

 Increase your productivity. A 32-bit architecture delivers better 

performance and reliability in areas such as networking, printing 

communicating and multimedia. 

 Work on several tasks at once. With fast, new 32-bit programs that support 

preemptive multitasking and multithreading and run in their own memory 

space, so errant programs can‟t affect one another. 

 Focus on your documents instead of the programs that created them. 

Programs that use OLE, Microsoft‟s strategic object technology, let you 

create and edit documents easily, allowing you to work not only within a 

single documents, but within multiple programs. 

 Built in networking. Windows 95 is network ready, providing easy 32-bit 

access to network resources, even simultaneously. 

 Play today‟s hottest games on Windows 95, thanks to faster graphics 

support for Windows based action games. 

(iii) compatibility is built-in 

 works with all your current software 

 Run on today‟s PC platform. Use Windows 95 on a PPC with as little as 4 MB 

of memory and a 386DX processor. 

 Reduce support burden. A more intuitive interface guides users through tasks 

and greater system reliability, through protected-mode networking, reduces 

downtime-both of which previously required helpdesk intervention. 

 Increase control of the desktop. Centralized security, remote administration 

and a registry that stores each user‟s environment. 

 Improve end-user productivity with the intuitiveness, speed and power of 

Windows 95. for example , Windows 95 reduces the complexity of remote 

computing with built-in dial-up networking and support for plug and play 

hardware. 

 Smooth migration to Windows 95. Testing shows users of Windows 3.1 

becoming more productive after just one hour with Windows 95 and end-users 

transition is eased with reference aids such as a computer-based tutorial and 

powerful new help system.   

 

2.   Logging On To The Windows: 
 

When you start Windows, you may be prompted to log on to Windows or, if you are on a 

network, to log on to your network. You don‟t want to log on with a password, don‟t type 

anything in the password box and click OK. You won‟t see this prompt in the future. 

To log on to Windows, do the following: 
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 In the User name box, type your name. 

 In the password box, type a password. The first time, Windows prompts you to 

confirm your password. 

 Choose OK push button. 

 

 

 

3.   Shutting Down The Windows: 

The  term shut down can be used to mean "turning off" something, but most 

commonly used for computers. To quit windows and shut down your computer, the 

following steps have to be performed: 

 Click the start button and then click the Shut down. 

 

http://en.wikipedia.org/wiki/Computer
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 A window appears that contain certain option like log off, sutdown or restart the 

computer, the user can select the option according to its convenience. 

 

 Choose the option and then, click O.K. 

4.   Start Button: 
 

The Start Menu and Start Button are user interface elements in the Microsoft Windows 

product line, which serve as the central launching point for applications. By default, the 

Start Button is visible at all times in the lower left-hand corner of the screen. Clicking the 

Start Button, it activates the Start Menu. The Start Menu provided a customizable nested 

list of programs for the user to launch, as well as a list of most recently opened 

documents, a way to find files and get help, and access to the system settings. The Start 

Menu provides a much easier way to open programs, even for experienced users. 

 

 

Command Description 

Programs Display a list of programs you can start. 

Documents Display a list of documents that you have opened previosly. 

Settings Display a list of system components for which you can change the 

setting. 

Find Enable you to find files, folder etc. 

Help Start Help 

Run Starts a program or opens a folder when you write command sin it. 

Shutdown Shutdown or restart your computer. 

 

http://en.wikipedia.org/wiki/Graphical_user_interface
http://en.wikipedia.org/wiki/Microsoft_Windows
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Users may add entries by creating various folders and shortcuts in the Start Menu folder, 

located in the hard drive. These appear in a separated section at the top of the Start Menu, 

or, if placed in the Programs sub-folder, in the Programs menu. In the Windows 95, 

Windows 98 and Windows Me, it is located in C:\Windows\Start Menu, or, if there are 

multiple users, C:\Windows\Profiles\username\Start Menu. 

 

5.   TaskBar: 
 

In computing, the taskbar is a term for the application desktop bar which is used to 

launch and monitor applications in Microsoft Windows 95 and later operating systems. In 

Windows, the default location for the taskbar is at the bottom of the screen, following 

Fitts' law, and from left to right it contains by default the Start menu, Quick Launch bar. 

 

 The Start menu contains commands that can access programs, documents, and 

settings. 

 The Quick Launch bar, introduced with Internet Explorer 4, contains shortcuts to 

applications. 

 

When ever you start a program, a button  representing that window appears on the 

taskbar. To switch between the windows , just click the button for the window you want 

from the task bar. When you close the window, its button disappear from the task bar. 

Start Menu 

Start Button 

http://en.wikipedia.org/wiki/Windows_95
http://en.wikipedia.org/wiki/Windows_98
http://en.wikipedia.org/wiki/Windows_Me
http://en.wikipedia.org/wiki/Computing
http://en.wikipedia.org/wiki/Microsoft
http://en.wikipedia.org/wiki/Windows_95
http://en.wikipedia.org/wiki/Operating_system
http://en.wikipedia.org/wiki/Fitts'_law
http://en.wikipedia.org/wiki/Start_Menu
http://en.wikipedia.org/wiki/Internet_Explorer
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6.   Starting A Program: 
 

1. Click the start button and then point to programs. 

2. Point to the folder, such as Accessories which contains the program and then click 

the program. 

 
 

One can add a program to the top of the start menu by dragging its icon onto the start 

button. 

(i) When you set up Windows, you see several programs, such as Windows 

explorer and MS-DOS prompt and several folders on the programs menu. 

Each folder contains programs that are grouped together for easy access. 

(ii) Windows also includes the StartUp folder, in which you can put programs you 

want to start automatically when you start Windows. 

(iii) When you install new programs on your computers, you may see additional 

folders. 

(iv) If you upgraded from a previous version of Windows, your old program 

groups appear as folders. 
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7.   Quitting A Program: 
 

(i) Click the close button in the upper-right corner of the window. 

OR 

(ii) Choose File Menu and then Choose close option. 

One can run as many programs as you want at the same time. Windows makes it easy 

to switch between programs or windows. 

 

8.  Switching between programs 
 

Click the taskbar button for the programs you want to open. Note that front of the 

other Windows. 

 

9.   Opening A Document: 

 
There are several ways by which one can open documents in Windows. 

 Open your documents by using the program you used to create it. 

 Use the documents command on the start menu to open a document you have 

opened recently. 

 Use the find command on the start menu to locate the documents. 

 Double-click a document icon in my computer folder. 
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Opening a document by using a program 

 

1. On the file menu, click open option. 

 
2. To open a document in a different folder, click the arrow next to the look in box 

and then click the disk that contains the folder. 

 
3.  Click the folder that contains the document you want to open and then click open. 

You may have to scroll to see more folders. 
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4. Click the documents you want to open and then click open. You can also double 

click on the documents to open it.   
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Opening A Document By Using Document Menu 

When you want to open the documents that are recently used, then it is availble in the 

document sub menu. It is one of the important facility for opening a document or a 

program that you use often.  

 

 Click the start button and then point to the documents. 

 Point to the document that you want to open, and then click it. 

10.   Getting Help: 
 

Help is a strong word used to indicate distress or the need for assistance. It is one of 

the important features of windows operating system. It gives detail information about 

all the features and how to use it. 

 Click the start button and then click the Help options. A windows appears that 

contain the list of all help topics.  
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 This information can be acessed by clicking on it. Then, its details come at the 

side of the window like this: 

 

To get help: 

 

 Click the start button and then click help option. 

 The list of help topics appears. You can use the tabs is help to search for 

information in several ways. 

 When you open help by using the start menu , or the help menu in my 

computer or windows explorer, we see help for windows in general. 

 

To find help through the content, do the following, 

 

 Click the contents tab to find topics grouped by subject and then follow the 

instructions on screen. 

 To return to the list of topics, click help topics. 

 

To find help through the index, do the following, 
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 Click the index tab to find specific topics listed alphabetically and then follow the 

instruction on screen. 

 To return to the list of topics, click help topics. 

To find help topics containing a word or phrase, do the following, 

 

 Click the find tab to find all the topics that contain specific word for phrase and 

then follow the instructions on the screen. 

 To return to the list of topics, click help topics 

 

To get help on a specific item, do the following, 

 

 For information about an item in a dialogue box, click ? and then click the item. 

 A pop-up explanation appears. Click it to make it disappear. 

 

11.   Finding Files & Folder: 
 

The find program is a search utility program.When you don‟t know the location of  a 

particular file then it can be searched by the help of Find command which is present in 

the start menu. 

 Click the start button and then point to the Find options. 

 Point to the option that you want to search either it is a file or folder present on 

the disk or the virus  and then click it. 

 

 When you click on Files or Folder option then a windows appears. 

http://en.wikipedia.org/wiki/Search_utility
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It has a text for the files which is to be searched And the text box for the drive location 

also where it is to be searched. For searching we can use wild card character i.e. (*). Wild 

card character is a character that consist of one or more unknown characters. Wild card 

characters are used when either you don‟t know the name and type of the file exactly. 

 

12.    Changing System Setting: 
 

To change windows settings, do the following, 

 

1. Click the start button and then point to settings. 

 
2. Click control panel. The control panel dialog box appears. The icons appears in 

control panel vary depending upon the hardware and software installed on your 

computer. 
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3. Double click a display icon to see the settings you can change. 

 

We can use a control panel for changing our screen colors, installing or changing settings 

for hardware and software and setting up or changing settings for a network. 

 

To see more settings, click the tabs at the top of the dialog box that appears. 

 

 
 

13.    Starting A Program By Making Use Of Run Command 

In simple run means to execute a program. If you know the exact location of a file the 

you can open it directly through the help of Run command. To start a program or 

open a folder we have to perform the following steps: 

 Click the start button and then click the Run. 
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 Then Window appears where we can type the name of the program. Or click 

Browse to look for the item. 

 

14.    Seeing What’s On Your Computer: 
 

In windows 95, the things you have on your computer are all accessible from one place 

called My Computer. To see the hierarchy or folders, do the following, 

 

 Click the start button, point to programs and then click windows explorer. 
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 Another way to open windows explorer is to use the right mouse button to 

click the My Computer. Then click explorer. 
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 To show or hide folders on the left side of the window, click the plus or 

minus sign beside the folder. 

 We can open the document or start a program by double click on its icon 

in the right side of the window. 

 We can look at the contents of our computer in different ways by using the 

VIEW menu. 

 To display the previous folder, do the following, 

 

   If the tool bar is not visible, click view and then click tool bar. 

 On the tool bar, click the up one level button. 

 

15.   Organizing Files & Folders: 

A folder is a collection of programs and files which is stored on disk. A folder can 

contain other folder, when they are said to be nested. In the DOS world, a subdirectory is 

equivalent of a folder. Steps for creating a folder: 

 Right click the mouse button, then a Menu appears. 

 In that menu click the New option, then a submenu appears. 

 In that submenu select the folder option, it will create a new folder. 

 

 

15.1 Opening Files or folder 

To work on the any file or the data of a file,first you have to open that file or folder. To 

open either file or folder do the following steps: 
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 Double-Click my computer on desktop 

 Double-Click on the drives in which the filesor folder is present. 

 On finding it, double click it. 

 

15.2 Copying And Moving Files or Folder 

Copy a file or folder means creating a duplicate copy of it but moving a files or folder 

means cut the files and folder from its place and aste it to the new destination, It does not 

make a copy. 

 Select the item(s) you want to copy or move. 

 Hold down the mouse button and drag the item(s) to the new location. If this is a 

regular file, the file will be copied. If it's an executable file, a shortcut is created. 

Or Right-click and select Copy from the pop-up menu. You could also select 

Copy from the Edit menu or press Ctrl+C.. 

 Access the destination location, then right-click and select Paste from the pop-up 

menu. You could also select Paste from the Edit menu or press Ctrl+V. 

15.3 Renaming Files and Folder 

To rename a file or directory, follow these steps: 

 Right-click on the file or directory name and then select Rename from the pop-up 

menu. Or select the file or directory name and then select Rename from the File 

menu. 

 The resource name is now editable. Enter the new name for the resource. 

 Press Enter or click on the resource's icon. 

 

15.4   Deleting Files and Folder 

To delete files and directories, follow these steps: 

 Select the items to be deleted. 

 Press the Delete key or choose Delete from the File menu. 

 

15.5 Examining File and Folder Properties 

Windows NT Explorer, My Computer, and Network Neighborhood all let you examine 

the properties of files and folders. There are two ways you can do this: 

 Right-click on the file or folders icon and then select Properties from the pop-up 

menu. 
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 Select the file or folder by clicking on it and then select Properties from the File 

menu. 

Folder and file attributes include: 

Read-only Shows whether the file or folder is read-only. Read-only files and folders 

can't be modified or accidentally deleted. 

Archive Shows whether the file or folder should be archived. If set, the backup utility 

will copy the file to the archive and then turn off the check box. 

Compress Shows whether the file is compressed. This is only available for NTFS. 

Hidden  Determines whether the file is displayed in file listings. You can override this by 

telling Windows NT Explorer to display hidden files. 

System Shows whether the file is used by the operating system. For non-system files, this 

box is usually shaded. 

 

 

15.6 Copying File To A Floppy Disk 

 

 Insert the floppy disk into your computer. 

 Double click My-Computer option. 
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 Copy the files which are to be copied in the floppy disk, from its destination. 

 Double click the 3 ½ floppy disk drive. 

 Paste the file by right clicking of the mouse, then click paste option from the 

menu which appears. 

 

16.    Creating A New Folder: 

 
 Double click My Computer and then double click the disk drive or folder in which 

we want to place the new folder. 

 On the File Menu, point to new and then click folder. 

 
 Type the name of new folder and then press enter. 

 

17.    Selecting Multiple items: 
 

We can select multiple item by pressing and holding down the CTRL key as we click  

each item we want , or by clicking select all on the edit menu to select every item in the 

Window. 

 

18.   Working With In Documents: 
 

As we work, we often need to copy and move information from one document to another, 

or one place to another within another. 

 

18.1   Selecting A Portion Of Text 
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The Select feature is a powerful tool. Whenever you want to work with a specific section 

of text, you can select just that portion and work on it separately from the rest of the 

document. Selecting text gives you maximum flexibility because you can isolate the text 

or other items that you want to work with. Select the portion of the document that you 

want to copy. There are two ways of selecting the data one with the mouse and other with 

the key board. With the mouse, click at the place from where you want to copy, hold 

down the button , and move the mouse in the direction you want to highlight. When the 

Desired text is highlighted, release the mouse button. Through the help of key board we 

can select the data by making use of SHIFT and ARROW keys. The selection bar is a 

vertical bar to the far left of the document between the horizontal ruler and view button. 

 
 

18.2   Copying The Selected Text 

To make a duplicate part of a document and reproduce it else where. The material copied 

can range from a single character to certain pages of text. 

Step1:  Select the data that you want to copy. 

Step2: Right-click and select Copy from the pop-up menu. You could also select 

Copy from the Edit menu or press Ctrl+C. 
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18.3   Cutting Selected Text 

To remove the marked portion of the document into a temporary storage area. The cutting 

of text is done, suppose you write the data in the place where it doesnot needed but the 

data is used in some other part of the document then you have to cut the data from the 

unwanted part and paste the data in the area where it is desired from the clipboard. 

Clipboard is an area of memory which is used for temporary storage of text from where it 

is being transferred. 

Step1:  Select the data that you want to cut. 

Step2: Right-click and select Cut from the pop-up menu. You could also select 

Cut from the Edit menu or press Ctrl+X.  

 

Step 3: After clicking cut the document appears like this: 
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18.4   Pasting Selected Text 

Paste means to insert text or graphics that has been cut or copied from one document  into 

another place in the same document or in to a different document. 

Step1:  Select the data that you want to copy. 

Step2: Right-click and select Copy from the pop-up menu. You could also select 

Copy from the Edit menu or press Ctrl+C. To cut the document select 

either cut from the menu or press Ctrl+X from the keyboard. 

Step 3: Put the cursor at the destination location, then right-click and select Paste 

from the pop-up menu. You could also select Paste from the Edit menu or 

press Ctrl+V. 

 



MYcsvtu Notes 

www.mycsvtunotes.in 24 

 

19.   Saving A Document 

Step1: Start Microsoft Word. 

Step2: In the New Document task pane, click Blank document under New. 

Step3: Write the data in the document. After completing the document go to 

step4. 

Step4: On the File menu, click Save. 

Step5: In the File name box, type the file name that you want for your document, 

and then click Save. 

 

We can also save the document as web page. The following steps are to be performed: 

Step1: Start Microsoft Word. 

Step2: Create a new blank document. 

Step3: On the File menu, click Save as Web Page. 

Step4: In the File name box, type the file name that you want for your document, 

and then click Save. 
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20.   Setting Up A Printer: 
 

It is a computer peripheral that presents the computer output as a printed image on 

paper or film. When we connect a new printer to our personal computer then first it 

has to be installed. For installation following steps are to be performed. 

 Click the start button and then click the Setting option and then click control 

pannel. 

 In the control pannel window, click printer option. 

 

 Inside the printer option, there is add printer option which is to be clicked. 
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 Add printer wizard appears on the screen. In that click Next button. 

 

 Again a new window appears which contain the option of which type of 

printer is to be attached either local printer or network printer. Local printer is 

that printer which is directly attached to the system in which you are working. 

Network printer is a printer in which printer is attached to the any other 

computer in the network. Select one of the option and click Next. 

 

 In case of local printer, after clicking the Next the wizard the system searches 

for the printer. Once you have located the printer you wish to install, click 

Next. 
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 Supply a name for the printer and determine whether you'd like this printer to 

serve as your default printer. It's always best to select the printer directly 

connected to your computer as your default printer. 

 Click Yes to print a test page from your newly installed printer. 

 Click Next to review the settings for your new printer before completing the 

installation process. 

How to install a network printer 
 

Installing a network printer that's down the hall from your main home computer is just as 

easy. When the Add Printer Wizard asks you to select a printer, simply click Connect to 

This Printer. If you don't know the name of the network printer, you may select Browse 

for a Printer to search through a list of shared printers. Alternatively, if your network 

printer is on a network that uses an Internet address, click Connect to a Printer on the 

Internet and enter the address in the URL text box. The Add Printer Wizard can guide 

you through the installation process, but playing with preferences is up to you. 

21.   Print Preview 

The Print Preview feature shows you how your document will look when you print it. 

Print Preview offers the advantage of seeing multiple pages of your document in a 

smaller size. To use the Print Preview feature, do the following: 

Choose File, Print Preview from the menu. The current page is displayed 
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Most of the buttons in Print Preview are self-explanatory. The others, like the Magnifier 

button, are not, so I'll try to clarify them here: 

 Magnifier—Click this button to turn on Magnifier. Then click the section of 

text that you want to magnify. Click the text again to go back to "normal." 

 Multiple Pages view—Click this button to open a palette of pages. Click and 

drag across the palette to select the number of pages you want to view at once. 

 Shrink to Fit—Click this button to activate the Shrink to Fit feature, which 

makes small adjustments that allow the text to fit on one page. 

22.   Printing A Document 

 Step1: On the File menu, click Print.  

 Step2:: Under Page range, specify the portion of the document you want to print. 

If you click Pages, you must also enter the page numbers or page ranges 

you want to include, or both. 

       Step3: To print the current page, choose Current Page. 

  Step 4: To print multiple pages, type the page numbers that you want to print in 

the Pages text box. For example, if you need to print pages 3 through 9, 

type 3-9. If you also want to print page 15, type 3-9, 15 in the text box. 

        Step 5: To print selected text, select the text before you open the Print dialog 

box. Then choose Selection. 

        Step6: After selecting all the options. Click print. 

23.   Installing Hardware 

Installing hardware means to configure and prepare hardware for operation. To install 

the hardware, the following steps has to be performed. 

 Click the start button and then click the Setting option and then click control 

pannel. 

 In the control pannel window, Double click Add/Remove hardware. 
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 Follows the instruction given on the screen. 

 

24.   Installing Software 

For instaling software there is a installation program that we have to run. Installation 

program is a program whose sole function is to install another program. To install the 

software, the following steps has to be performed. 

 Click the start button and then click the Setting option and then click control 

pannel. 

 In the control pannel window, Double click Add/Remove program. 
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 Follows the instruction given on the screen. 

 
 

 

25.   Putting A Shortcut On The Desktop: 

Computer shortcuts are small files containing only the location of another file. When a 

shortcut is double clicked, the original item opens The steps through which we can create 

a shortcut to any files are: 

 To create a shortcut for a program in Windows, you can right click on the file and 

go to Create Shortcut. 
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 After creating the shortcut, you can use the shortcut as it is or  there are ways to 

modify how the program will run. 

 To modify the shortcuts, right click the shortcut you just created and go to 

Properties. In the Target Field, you can add command line switches to the end to 

modify how the program will run. 

 

It is also important to remember that if a shortcut is added to a removeable device like in 

a CD or floppy disk then  the drive letter may change when the device is plugged into a 

http://en.wikipedia.org/wiki/Switch_(command_line)
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different computer. This would result in a break in the shortcut, and it would not operate 

properly even though the file that it is linked to still exists or they will not even open the 

document and gives the message that document doesn‟t exist. 

Program Start Automatically: 

To setup a program to start when Windows starts, do the following: 

 In Windows Explorer, locate the program we want and then use the right mouse 

button to click it. 

 
 Click the plus  signs next to the windows folder, the Start menu folder and then 

the programs folder. 
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26.   Network 

Computer networking is the scientific and engineering discipline concerned with 

communication between computer systems. Such networks involve at least two devices 

capable of being networked with at least one usually being a computer. The devices can 

be separated by a few meters (e.g. via Bluetooth) or thousands of kilometers (e.g. via the 

Internet). Computer networking is sometimes considered a sub-discipline of 

telecommunications. 

Advantages: 

 

 We can use programs and documents from another computer without passing 

floppy disks back and forth. 

 We can print documents on a printer attached to another computeror use another 

computers fax modem, just as if they are connected to our computer. 

 We can access to the internet. 

 Message transactions using e-mail is possible. 

 

26.1    Network Neighbourhood(NN): 
 

If our computer is connected to the network, the NN icon appears on desktop. When we 

double-click NN, we might see the computers in our workgroup or any NetWare servers 

we are connected to. Generally, our workgroup has been set up by an administrator so 

that the computers it its contain most of the resources we want to use. We can see other 

computers on the network those not in our workgroups by double clicking the Entire 

Network icon which appears in Network Neighbourhood.  

 
 

26.2  CONFIGURING COMPUTER TO A NETWORK 
 

A.   Setting up network software 
 

 Click the start button, point to settings and then click control panel. 
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 Double click Network. 

 
 Click Add. 

 
 Click adapter and then click add. 

 



MYcsvtu Notes 

www.mycsvtunotes.in 35 

 
 Follow the instructions on your screen. If we don‟t know what kind of adapter we 

have. 

When we set up a network adapter, windows automatically sets up the other network 

components we need to use the network. 

Followings are the descriptions of the network components. 

 Client software enables we to connect to network resources such as folders and 

printers that have been shared on computers on the network. 

 A network adapter is an expansion card or other device that physically connects 

our computer to the network. 

 A protocol might be called the language our computer uses when communicating 

over the network. 

 Service software includes services such as file and printers sharing for our 

computer or automatic backup to a network server. 

 

B.  Identifying computer on the network 
 

 In the network dialog box, click the identification tab. 

 Type a name for our computer, our workgroup name and a brief description of 

your system that other people will see when they look at our computer on the 

network.  

 
 

27.   Sharing Folder & Printers 
 

There are two ways to grant people access to the folders and printers we share over the 

network. 
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 Share-level access control: Anyone wanting to use the shared resource must 

know the password we have assigned to it. 

 User level access control: as we share a resource, specify the names of people or 

groups who are authorized to use it. If we choose this type of access, we need to 

specify the computer or domain where the list of authorized users is located. 

 

The dialog box appears for sharing a file and folder: 

 

 
 

A.   Sharing a folder: 
 Locate the folder we want to share and click it. 

 
 On the file menu, click sharing. 
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 Click the options we want. 

 
B.  Sharing a printer: 

 
 Click the start button, point to settings and then click printers. 

 
 In the printer‟s window, click the printer we want to share. 
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 On the file menu, click sharing. 

 
 Click the options we want. 

 

28.  Using Resources Located On Other Computer 

A.   Using a shared folder 
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 Double click the Network Neighbourhood. 

 
 Double click the icon for the computer that contains the folder we want. 

 
 Double click the folder that contains the document or program we want. 

 If the computer is not in our workgroup, double-click Entire Network. 

 We can also create a short cut to a network resource. 

 We can use the Find and Run commands on the start menu to find network 

resources. 

 To use a printer that has been shared on the network, we need to set up the 

printer on our computer. 

 
29.  USING DIAL-UP NETWORKING 
 

We can use Dial-up networking to connect to our office computer and the network it is 

on. By using a modem and dialing into the computer, we can use any shared resources, 

such as a folder or printer on the computer or network. To connect two computers in this 

way, they must both have modems installed. We must also set up Dial-up Networking on 

both computers and the computer we want to dial into must be set up as a server. If there 

is no Dial-up networking in the My Computer window, we can use the following 

procedure to install it. 

  

A.   Setting up Dial-up Networking 

 
 Click the start button, point to settings and then click control panel. 
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 Double click Add/Remove programs. 

 
 Click the windows setup tab, click communication and then click details. 
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 Click the Dial-up Networking check box and then click ok. Click ok again and 

follow the instructions on our screen. 

 
 Double click My Computer and then Double click Dial-up Networking. 
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 Follow the instructions on our screen. 

 

30.  CONNECTING TO THE INTERNET 

 

The internet is a worldwide network of computers, which hold large amounts of data that 

you can easily access from a PC. Besides, you can communicate with others worldwide 

with the help of email. You can also communicate „live‟ in On-line chatting. You need 

not to be a computer expert to use the Internet. To understand how the Internet works 

first you have to understand Networking 

 

 Using the Microsoft Network, a new online service, we can gain access to Internet 

news groups, download software and send and receive e-mail over the Internet. 

To sign up for the Microsoft Network, double click the icon for the Microsoft 

Network on our desktop. 

 Generally, to connect to the Internet, you need a computer and a modem. A 

modems converts data so that it can be sent through the telephone line. In 

windows, you are provided with Dial-UP Network to get connected to the 

internet through the telephone line. You also need an account with a service 

provider, who will connect you with the Internet. 

 

31.  Having Fun 

 
Explore Sound & Animation 
 

Windows provides many multimedia features. We can use CD player to play audio 

compact disks, sound Reader to play or record sounds or Media player to view 

animations. 

 

A. CD Player 

CD player, is an electronic device which plays audio Compact Discs. CD players are 

often installed into home stereo systems, car audio systems, and personal computers. In 

personal computer we can use CD player to play audio/video data, or seeing some data 

which is stored in CD, these data may be either text/pictures. For playing audio/video 

data you must have a sound card installed in your PC because without it you cannot listen 

to a CD. Steps for using CD Player: 

 Click start, and then select program option, then point to Accessories. After that, 

select Entertainment. 

 From the entertainment submenu, we will select the option CD player. 

 

http://en.wikipedia.org/wiki/Compact_Disc
http://en.wikipedia.org/wiki/Stereophonic_sound
http://en.wikipedia.org/wiki/Car_audio
http://en.wikipedia.org/wiki/Personal_computer
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 CD player dialog box open 

 

B. Window media player 

Windows Media Player (WMP) is a digital media player and media library application 

developed by Microsoft that is used for playing audio, video and images on personal 

computers running the Microsoft Windows operating system. In addition to being a 

media player,  Windows Media Player includes the ability to rip music from, and copy 

music to compact discs, synchronize content with a digital audio player (MP3 player). 

The default file formats are WMV (Windows Media Video & Audio), WMA (Windows 

Media Audio), and ASF (Advanced Streaming Format), and supports its own XML based 

playlist format called WPL (Windows Playlist). Steps for using media Player: 

 Click start, then select program option, then point to Accessories. After that, 

select Entertainment. 

 From the entertainment submenu, we will select the option window media 

player. 
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http://en.wikipedia.org/wiki/Media_player
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Window media player dialog box opens. 

 

C. Sound Recorder 

Sound recording and reproduction is the electrical or mechanical inscription and re-

creation of sound waves, usually used for the voice or for music.  For recording a sound 

in your personal computer microphone is a necessary device. Steps for using sound 

recorder: 

 Click start, and then select program option, then point to Accessories. After that, 

select Entertainment. 

 From the entertainment submenu, we will select the option sound recorder. 

http://en.wikipedia.org/wiki/Electrical
http://en.wikipedia.org/wiki/Mechanics
http://en.wikipedia.org/wiki/Sound
http://en.wikipedia.org/wiki/Voice
http://en.wikipedia.org/wiki/Music


MYcsvtu Notes 

www.mycsvtunotes.in 45 

 
 

 

Play Games: 

 

If you are looking for a fun challenge, try the games that come with Windows. For 

example, solitaire is one of the most popular card games off all time. 

 

 
 

32.  Set Up A Screen Saver: 

Screen Saver is a utility program that blanks the computer screen after a period of in 

actiity.A screensaver is a computer program originally designed to conserve the image 

quality of computer displays by blanking the screen or filling them with moving images 

or patterns when the computers are not in use. Today, screensavers are primarily used for 

entertainment or security purposes. When the same image is displayed on a CRT screen 

for long periods of time, the properties of the exposed areas of phosphor coating on the 

inside of the screen gradually and permanently change, eventually leading to a darkened 

shadow or "ghost" image on the screen.  

Screensaver programs were originally designed to help avoid these effects by 

automatically changing the images on the screen when the computer was not in use (thus 

"saving" the screen). They can be usually set up to launch automatically, waiting a 

specified amount of time after the last keystroke or the last mouse movement made by a 

http://en.wikipedia.org/wiki/Computer_display
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user. The screensaver remains active until a user presses a key or makes a mouse 

movement. At that moment, the screensaver closes and the former screen contents are 

restored, allowing the user to work again. 

 Right Click on the blank area of desktop. 

 A small menu is displayed. Click on the property option. 

 Then Display property dialog box appears 

 To set the screensaver, click on the screensaver tab. 

 Select any of the screen saver which is present in the screen saver listbox. Your 

selection will be displayed on the little monitor of property window. 

 You can also see the preview of the screen saver by clicking on the preview tab. 

 You can also set the time after which the screen saver should be active by clicking 

on the arrow button 

 

 There is a setting button through which we can set the texture of the selected 

screen saver from the dialog box which appears after clicking on it.  
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33.  Change the appearance of Windows 
 

We can personalize Windows with pictures, patterns and colors by using Control panel. 

We can display pictures or patterns as “Wallpaper” for Windows or use our own scanned 

photos. We can also change our windows colors to an existing scheme or create our own. 

 
 

Wallpaper is material which is used to cover and decorate the interior walls of homes, 

offices, and other buildings; it is one aspect of interior decoration.."Wallpaper" is also a 

term for computer wallpaper, referring to an image used as a background on a computer 

screen, usually for the desktop of a graphical user interface. "Wallpaper" is the term used 

in Microsoft Windows, while the Mac OS avoids mixing metaphors by calling it a 

'desktop picture'. For adding wallpaper to a desktop certain steps must be followed: 

 Right Click on the blank area of desktop. 

 A small menu is displayed. Click on the property option. 

 

 Then Display property dialog box appears 

 To set the wallpaper click on the Background tab. 

 Select any of the wallpaper which is present in the listbox. Your selection will be 

displayedon the little monitor of property window. 

http://en.wikipedia.org/wiki/Wall
http://en.wikipedia.org/wiki/Interior_decoration
http://en.wikipedia.org/wiki/Computer_wallpaper
http://en.wikipedia.org/wiki/Desktop
http://en.wikipedia.org/wiki/Graphical_user_interface
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 You can also browse certain other pictures also which is present on your disk 

drive by making use of browse button. 

 We can also set the picture either in the form of tiles, center, or in a stretched way 

from picture display list box. 

 
 

Steps For Setting The Appearance Of The Screen: 
 

 Right Click on the blank area of desktop. 

 A small menu is displayed. Click on the property option. 
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 Then Display property dialog box appears 

 

 To change the appearance of the desktop, click on the Appearance tab. 

 There are certain setting scheme which is given by the windows. We can select 

one from it from the scheme list box. 

 There are certain item provided in the item listbox, you can also change the 

property of the item by changing the colour and font sizes. 

 You can also see the preview of changing the appearnce on the small monitor 

which is provided in the dialog box. 

 After all changing has been done. Click ok. 

34.   Maintaining System: 

Windows provide tools that we should use regularly to maintain our hard disk. Look for 

these tools in the system Tools folder which is located in the Accessories folder. 

 

A.  Back up the information on our disk 
 

Backing up our files safeguards them against loss if our hard disk fails or we accidentally 

overwrite or delete data. 
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B.  Check and repair our disk by using ScanDisk 
 

ScanDisk can check the files and folders on our hard disk for data errors and it can also 

check the physical surface of the disk. 

 

35.  Optimizing Computer: 

Windows includes several features to improve our computer‟s performance. 

 

A.   Increase disk space by compressing data 
We can free up space on hard and floppy disks by using DriveSpace to compress the data 

that is on them. If our drive is uncompressed, Compressing it will generally give  50 to 

100 percent more free space. 
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B.   Defragment your disk 

 

Over time, files can become divided into fragments that are stored in different locations 

on our hard disk. These files are complete when we open them but it takes longer for our 

computer to read from and write to them. To defragment our files and speed up 

performance, use Disk Diskfragmenter.  

 

36.   COMMUNICATING WITH THE WORLD 
 

Windows provide several ways for you to communicate with co-workers and friends and 

with the rest of the world. 

 

A.  Share information by using electronic mail 

 
Microsoft Exchange features a universal Inbox where we can send and receive electronic 

mail and organize access and share all types of information, including faxes and items 

from online services. 
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B.  Send and receive faxes 
 

We can use Microsoft Fax to send and receive fax messages. All we need is a fax modem 

we can access on a network or one attached to our own computer. Incoming faxes appear 

as messages in our Microsoft Exchange Inbox. Microsoft Fax comes with a Cover Page 

Editor and a Fax Viewer for viewing faxes that cannot be edited. 

 

C.   Connect to other computers 
 

We can use HyperTerminal and a modem to connect to remote computer that is not 

running Windows. This enables us to easily connect to bulleting boards, host systems, or 

text-based online services. HyperTerminal even configures our modem for us and enables 

us to dial automatically. 

37.   Create Pictures By Using Paint: 

Microsoft Paint frequently called MS Paint or Paint and formerly Paintbrush for 

Windows is a simple graphics painting program that comes bundled with all versions of 

Microsoft Windows. The program opens and saves files as Windows bitmap, JPEG, GIF, 

PNG, and TIFF. Older versions cannot open or edit PNG files, and can only open GIF, 

JPEG, and TIFF files. 

The program comes with the following options in its Tool Box: Free-Form Select, Select, 

Eraser/Color Eraser, Fill With Color, Pick Color, Magnifier, Pencil, Brush, Airbrush, 

Text, Line, Curve, Rectangle, Polygon, Ellipse, and Rounded Rectangle. MS Paint does 

not have the ability to automatically create color gradients. 

The default colors in the Color Box could be described as the following colors: Black, 

White, Gray, Silver, Maroon, Red, Olive, Yellow, Dark Green, Green, Teal, Cyan, Navy 

blue, Blue, Purple, Magenta, Old Gold, Lemon Yellow, Slate grey, Kelly green, Dark 

Carolina blue, Aquamarine, Midnight blue, Periwinkle, Violet-blue, Coral, Brown and 

Pumpkin orange. A colour palette is also available. 

Steps for creating a paint document 

 Click start, and then select program option, then point to Accessories. After that, 

select paint. 

 Paint windows open where you can draw certain graphics. 
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38.   How To Use Wordpad: 

WordPad is a simple word processor that is included with almost all versions of 

Microsoft Windows from Windows 95 upwards. It is more advanced than Notepad, 

but not as advanced as Microsoft Word. It originated in Windows 3.1. It has facilities 

to format and print text, but lacks intermediate features such as a spell checker and 

thesaurus. WordPad supports Rich Text Format. This file format is the default format 

used by the editor to store and load files. WordPad for Windows XP cannot save files 

in the .DOC format. 

 

Steps for creating a word pad document 

 Click start, and then select program option, then point to Accessories. After that, 

select word pad. 
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 Word pad windows open for performing certain operation like writing the text. 

The windows shows like this: 

 

 
 

39.  Internet Explorer 

Windows Internet Explorer, previously Internet Explorer, abbreviated IE , is a graphical 

web browser developed by Microsoft and included as part of the Microsoft Windows line 

of operating systems. It has been the most widely used web browser since 1999. After the 

first release for Windows 95, additional versions of Internet Explorer were developed for 

other operating systems: Internet Explorer for Mac and Internet Explorer for UNIX (the 

latter for use through the X Window System on Solaris. Internet Explorer was originally 

derived primarily from Spyglass Mosaic, an early commercial web browser. Internet 

Explorer 3 was the first major browser with CSS (Cascading Style Sheet) support. On 
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February 15, 2005, Microsoft Chairman Bill Gates announced that the new version of its 

browser would be released at the RSA Conference 2005 in San Francisco. Internet 

Explorer makes use of the accessibility framework provided in Windows. Internet 

Explorer is also a user interface for FTP, with operations similar to that of Windows 

Explorer. 

Some released version of internet explorer are: 

 On January 31, 2006, Microsoft released a public preview build  of Internet 

Explorer 7 for Windows XP Service Pack 2  on their web site. 

 On June 29, 2006, Microsoft released Beta of Internet Explorer 7 for Windows 

XP SP2, Windows XP x64 Edition and Windows Server 2003 SP1. It features re-

ordering of tabs by drag and drop, as well as noticeable performance 

improvements.  

 On September 28, 2006, 3Sharp, a privately held technical services firm, 

published the results of a study, commissioned by Microsoft,  evaluating eight 

anti-phishing solutions in which Internet Explorer 7 came out on top. 

 On October 18, 2006 the final version was released on microsoft.com, and was 

distributed as a high-priority update via Automatic Updates (AU) on November 1. 

Features of Internet Explorer: 

 For better security, Internet Explorer is no longer integrated with the Windows 

Explorer shell. Local files typed in IE7 are opened using the Windows Explorer 

shell and websites typed in Windows Explorer shell are opened using the default 

web browser.  

 There is a "protected mode" (available in Windows Vista only), whereby the 

browser runs in a sandbox with even lower rights than a limited user account. As 

such, it can only write to the Temporary Internet Files folder and cannot install 

start-up programs or change any configuration of the operating system without 

communicating through a broker process.  

 A number of improvements to CSS, DOM, and HTML support have been made. 

While it is not officially possible to keep multiple versions of Internet Explorer on the 

same machine, some hackers (Joe Maddalone, Ryan Parman, et al.) successfully 

separated several versions of Internet Explorer making them standalone applications. 

These were referred as "standalone" IEs and included versions 3.0 to 5.5. 
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40.  TV VIEWER 
 

The old question “what‟s on TV?” may never mean quite the same thing after we try out 

the Windows 98 TV Viewer. This new application may seem a bit ahead of its time, but 

who ever thought computers would come as far as they have in such a short time? With 

the TV Viewer we can view local television schedules, search for particular shows, have 

our PC remind we when our favorite show will be on and with the right equipment, even 

watch high-definition TV right on our PC‟s monitor. 

 

 

Utilities Of Windows-98 
 

 

41.  SYSTEM INFORMATION UTILITES 
 

It provides a wealth of interesting information about our PC. Much of this information 

can be quite valuable for troubleshooting purposes. We probably won‟t have much need 

for this troubleshooting information. But if our system experiences problems then we will 

be able to provide the technical support person with information that may help us  to 

solve the problem more quickly. 

 

Follow these instructions to view system information 

 Click the start button. 
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 Select programs->Accessories->System Tools->Microsoft System information 

utility. 

 Select the information category we want to examine. 

 Click the print button to create printed record of the selected category. 

 Click the close button to close the System information Utility. 

 

42.  SYSTEM FILE CHECKER 
 

The system file checker checks important Windows 98 system files to make certain they 

haven‟t been damaged or improperly overwritten. Files can be damaged if our system 

crashes. In addition, poorly written software installation programs can replace important 

system files with out-of-date version that may cause our computer to malfunction. 

 

Follow these instructions to verify that our system files are okay: 

 Click the start button. 

 Select programs->Accessories->System Tools-> System File Checker to open the 

System File Checker. 

 Click start to begin checking for errors. 

 If System File Checker finds system files that have changed 

 Choose update verification information if we know the file has been updated, 

restore file if we want to revert to the original windows 98 file, or ignore if we are 

not certain but want to try the changed file. 

 Click ok to continue. 

 Select close to close the System File Checker.  

 

43.  WINDOWS TUNEUP WIZARD 
 

Our PC probably isn‟t running quite as fast as it could. The windows tune up wizard is 

intended to help us to get the most out of our system by making our favorite programs 

run faster, making certain our hard disk doesn‟t contain errors and making certain that 

disk space isn‟t being wasted on unnecessary files. 

 

Follow these instructions to run the windows tune up wizard: 

 Click the start button. 

 Select programs->Accessories->System Tools-> windows tune up wizard to open 

the windows tune up wizard dialog box. 

 Click next and select Do not optimize. 

 Click next to begin and see the scheduled tasks. 

 To view the schedule for a task, select the task in the list of scheduled tasks. 

 To change a task schedule, click the reschedule button to display the reschedule 

dialog box. We may want to reschedule any tasks reschedule for times when we 

normally use our PC.  

 After we have adjusted the schedule, click ok to close the reschedule dialog box. 

 Click next to continue. The windows tune up wizard then confirms the schedule. 

 Click finish to close the Windows tune up wizard dialog box. 


